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Safety Information

The attached "Safety Precautions" manual contains important information about the safe and correct
use of the ScanSnap. Make sure that you read and understand it before using the ScanSnap.

Safety Information
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Manuals

Read the following manuals according to your needs when using the ScanSnap.

Before Using the ScanSnap
Manual Description and Location

Safety Precautions This manual contains important information about the safe use of the ScanSnap.
Make sure you read this manual before using the ScanSnap.
This manual is included in the package.

In addition, when the software is already installed, this manual can be accessed as
follows: From the sidebar in Finder, select [Applications] → [ScanSnap Manuals], and
then double-click [S1300i Safety Precautions].

When Setting Up the ScanSnap
Manual Description and Location

ScanSnap S1300i Getting
Started

This manual explains the setup procedure from the moment you open the package to
testing the operations.
Getting Started is included in the package.

In addition, when the software is already installed, this manual can be accessed as
follows: From the sidebar in Finder, select [Applications] → [ScanSnap Manuals], and
then double-click [S1300i Getting Started].

When Operating the ScanSnap
Manual Description and Location

ScanSnap S1300i Basic
Operation Guide (this
manual)

This manual explains the basic operations and cleaning procedure for the ScanSnap.

ScanSnap Advanced
Operation Guide

This manual describes operations including various scanning methods and useful
usages of the ScanSnap.
You can refer to this manual at the following website.
http://www.pfu.fujitsu.com/imaging/downloads/manual/advanced/mac/en/common/
index.html

ScanSnap Manager Help This Help file describes the windows, operational troubles and the solutions, as well as
messages of the ScanSnap Manager.
This manual can be accessed by one of the following methods:

l Click the ScanSnap Manager icon  in the Dock while holding down the [control]
key on the keyboard, and select [Help] → [Help] from the "ScanSnap Manager
Menu" (page 35).

l Click the Help button ( ) for ScanSnap Manager.
l Select [Help] in the menu bar → [ScanSnap Manager Help].

Manuals
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When Saving Scanned Images to a Mobile Device
Manual Description and Location

ScanSnap Connect
Application User's Guide
(iOS)

This manual describes operations to be performed on an iOS-based mobile device
when you save scanned images to the mobile device.
This manual can be accessed by the following method:
1. Start up ScanSnap Connect Application on the mobile device.
a The [File List] screen appears.

2. Tap the [ ] button or the [ ] button.
a The [Information] screen appears.

3. Tap the [Help] button.

ScanSnap Connect
Application User's Guide
(Android)

This manual describes operations to be performed on an Android-based mobile device
when you save scanned images to the mobile device.
This manual can be accessed by the following method:
1. Start up ScanSnap Connect Application on the mobile device.
a The [File List] screen appears.

2. Open the menu.
Perform one of the following operations:
l Press the [Menu] button on the mobile device.
l Tap the [Menu] button displayed on the screen of the mobile device.
a The menu appears.

3. Tap the [ ] button or [Information].
a The [Information] screen appears.

4. Tap the [Help] button.

When Updating the Software
Manual Description and Location

ScanSnap Online Update
Help

This Help file describes the operations, windows, and messages of ScanSnap Online
Update.
This Help file can be accessed by one of the following methods:

l Click the Help button ( ) of ScanSnap Online Update.
l Select [Help] in the menu bar → [ScanSnap Online Update Help].

When Using Related Applications
Manual Description and Location

ScanSnap Organizer Help This Help file describes the operations, windows, and messages of ScanSnap
Organizer.
This Help file can be accessed by selecting [Help] in the menu bar → [ScanSnap
Organizer Help].

CardMinder Help This Help file describes the operations, windows, and messages of CardMinder.
This Help file can be accessed by selecting [Help] in the menu bar → [CardMinder
Help].

Manuals
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Trademarks

Microsoft, Windows, Windows Vista, Excel, PowerPoint, Outlook, SharePoint, Windows Live,
Internet Explorer, and Entourage are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

Word is the product of Microsoft Corporation in the United States.

Apple, App Store, the Apple logo, Mac, Mac OS, OS X, iPad, iPhone, iPhoto, iPod touch, and iTunes
are trademarks of Apple Inc.

Intel and Intel Core are registered trademarks or trademarks of Intel Corporation in the United States
and other countries.

ABBYY™ FineReader™ Engine © ABBYY. OCR by ABBYY

ABBYY and FineReader are trademarks of ABBYY Software, Ltd. which may be registered in some
jurisdictions.

Evernote is a registered trademark or trademark of Evernote Corporation.

Google, Google Docs, Android, and Google Play are registered trademarks or trademarks of Google
Inc.

Salesforce, the Salesforce logo, and Salesforce CRM are registered trademarks or trademarks of
salesforce.com, inc. in the United States and other countries.

Wi-Fi, Wi-Fi Protected Setup, and the Wi-Fi Protected Setup logo are trademarks of Wi-Fi Alliance.

ScanSnap, the ScanSnap logo, ScanSnap Manager, ScanSnap Organizer, CardMinder, and Rack2-
Filer are registered trademarks or trademarks of PFU LIMITED in Japan.

Other company names and product names are the registered trademarks or trademarks of the
respective companies.

Trademarks
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Manufacturer

PFU LIMITED

YOKOHAMA i-MARK PLACE, 4-4-5 Minatomirai, Nishi-ku, Yokohama, Kanagawa, 220-8567, Japan

© PFU LIMITED 2014-2015

Manufacturer
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Symbols Used in This Manual

The following indications are used in this manual to obviate any chance of accident or damage to
you and people near you, and your property. Warning labels indicate the warning level and
statements. The symbols indicating warning levels and their meanings are as follows.

Indication Description

�������

This indication alerts operators of an operation that, if not strictly observed, may result
in severe injury or death.

�������

This indication alerts operators of an operation that, if not strictly observed, may result
in safety hazards to personnel or damage to the product.

Symbols Used in This Manual
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Arrow Symbols in This Manual

Right-arrow symbols (→) are used to connect icons or menu options you should select in
succession.

Example: From the sidebar in Finder, select [Applications] → [ScanSnap].

Arrow Symbols in This Manual
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Screen Examples in This Manual

The screenshots used in this manual are of OS X v10.9.

However, some screenshots are of OS X v10.10.3 or later.

The actual windows and operations may differ depending on the operating system.

The screen examples in this manual are subject to change without notice in the interest of product
development.

If the actual window differs from the screen examples in this manual, operate by following the actual
displayed screen.

Screen Examples in This Manual
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Abbreviations Used in This Manual

Also, the following abbreviations are used in this manual.

Abbreviation Used Designation

Mac OS OS X v10.10, OS X v10.9, OS X v10.8, Mac OS X v10.7, or Mac OS X v10.6

Word Microsoft® Word for Mac 2011

Excel Microsoft® Excel® for Mac 2011

PowerPoint Microsoft® PowerPoint® for Mac 2011

ABBYY FineReader for
ScanSnap

ABBYY FineReader for ScanSnap™
All the descriptions in this manual assume the usage of ABBYY FineReader for
ScanSnap bundled with the ScanSnap. Unless otherwise specified, the term ABBYY
FineReader for ScanSnap refers to the ABBYY FineReader for ScanSnap bundled
with the ScanSnap.
Note that ABBYY FineReader for ScanSnap may be upgraded without notice. If the
descriptions in this manual differ from the actual displayed screens, refer to the
ABBYY FineReader for ScanSnap User's Guide.

Google Docs Google Docs™
Android Android™
ScanSnap Color Image Scanner ScanSnap S1300i

Abbreviations Used in This Manual
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What You Can Do with the ScanSnap

Scanning Multiple Documents
A document stack with a thickness of 1 mm (0.04 in.) or less (for A4 or smaller sizes: up to 10 sheets
with 80 g/m2 [20 lb] paper weight) can be loaded into the ScanSnap for scanning.

For details, refer to "Scanning a Document" (page 15).

Using the USB Bus-Powered Drive that Does Not Require Any Power
Supply
You can use the ScanSnap in an environment where no power supply is available, such as outside
or on a business trip, by connecting the ScanSnap to a USB port on a computer.

USB Cable

USB Bus 

Power Cable

What You Can Do with the ScanSnap
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Scanning a Document

You can scan documents such as handouts for meetings or business cards.

For details about documents that can be scanned, refer to "Documents to Scan" (page 44).

1. If you are loading multiple sheets, check the number of sheets.
The maximum number of sheets in the ScanSnap is as follows:

For A4 or smaller sizes: Up to 10 sheets can be loaded (with paper weight of 80 g/m2 [20 lb]
and thickness of the document stack under 1 mm [0.04 in.]).

ATTENTION
If you try to scan more than the maximum amount that can be loaded, the following problems
may occur:
l Files cannot be properly created due to excessive file size.
l Paper jams occur during scanning.

2. Fan the documents.
1. Hold both ends of the documents and fan them a few times.

2. Rotate the documents 90 degrees and fan them in the same manner.

3. Straighten the edges of the documents and slightly displace the top edges at
an angle.

BackAt an Angle

Feed Direction

ATTENTION
Paper jams or damage to documents may occur if you scan the documents without aligning the
edges first.

4. Open the ADF paper chute (cover) of the ScanSnap.

Scanning a Document
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ADF Paper Chute (Cover)

a The [Scan] button flashes in blue. The button returns to being lit normally when document
scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

5. Pull out the extension.

Extension

6. Load the documents in the ADF paper chute (cover).
Load the documents face-down and top-first with their back facing you. Adjust the number of
documents so that they do not go beyond the reference marks and are kept within the side
guides when they are loaded.

Side Guide

7. Adjust the side guides to the width of the documents.

Scanning a Document
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Hold each side guide in the middle to adjust them. Otherwise, the documents may be fed
skewed.

Documents

8. Press the [Scan] button on the ScanSnap to start a scan.

ATTENTION
Do not perform the following operations during scanning. Doing so will stop scanning.
l Connect or disconnect the ScanSnap and other USB devices.
l Close the ADF paper chute (cover).
l Switch users.
l Allow the computer to enter sleep mode.

a The [Scan] button on the ScanSnap flashes in blue while the documents are being
scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

a The Quick Menu appears when the scanning is completed.

9. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.

Scanning a Document
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a The selected application starts up. For details, refer to the Advanced Operation Guide.

ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning a Document
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Scanning a Long Page

Documents up to 863 mm (34 in.) in length can be scanned.

For details about documents that can be scanned, refer to "Documents to Scan" (page 44).

HINT
For details about how to load documents that are 360 mm (14.17 in.) or less in length, refer to
"Scanning a Document" (page 15).

1. Open the ADF paper chute (cover) of the ScanSnap.

ADF Paper Chute (Cover)

a The [Scan] button flashes in blue. The button returns to being lit normally when document
scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

2. Pull out the extension.

Extension

3. Load only one document in the ADF paper chute (cover).
Hold the document with your hand so that it does not fall out of the ADF paper chute (cover).

Scanning a Long Page
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4. Press the [Scan] button on the ScanSnap (for three seconds or longer) until
the button flashes in blue to start a scan.

ATTENTION
l Secure enough space where the scanned documents are ejected from the ScanSnap, and

pick up the documents with your hands to prevent them from falling off the unit where the
ScanSnap is placed on.

l Do not perform the following operations during scanning. Doing so will stop scanning.
- Connect or disconnect the ScanSnap and other USB devices.
- Close the ADF paper chute (cover).
- Switch users.
- Allow the computer to enter sleep mode.

HINT
When you scan the first page as a long page and continue scanning, the subsequent documents
are also scanned as long pages.

a The [Scan] button on the ScanSnap flashes in blue while the documents are being
scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

Scanning a Long Page
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a The Quick Menu appears when the scanning is completed.

5. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.

When you select , you can manage scanned images by folder with ScanSnap
Organizer.

For details, refer to "Managing Paper Documents by Folder on a Computer" (page 62).

a The selected application starts up. For details, refer to the Advanced Operation Guide.

Scanning a Long Page
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ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning a Long Page
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Scanning Documents of Different Widths or
Lengths in One Batch

Documents of different widths or lengths can be scanned in one batch.

For details about documents that can be scanned, refer to "Documents to Scan" (page 44).

1. Open the ADF paper chute (cover) of the ScanSnap.

ADF Paper Chute (Cover)

a The [Scan] button flashes in blue. The button returns to being lit normally when document
scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

2. Pull out the extension.

Extension

3. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and then select [Settings] from the "ScanSnap
Manager Menu" (page 35).
a The ScanSnap setup window appears.

4. In the [Paper] tab, select [Automatic detection] in [Paper size].

Scanning Documents of Different Widths or Lengths in One Batch
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5. Select [None] in [Multifeed Detection].

6. Click the [Apply] button in the ScanSnap setup window.

7. Click  at the upper left of the window to close the ScanSnap setup window.

8. Load documents in the ScanSnap.
1. Align the edges of the documents.

Scanning Documents of Different Widths or Lengths in One Batch
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2. Load the documents at the center of the ADF paper chute (cover).

ATTENTION
l Load all documents over one another above the pick roller (center). Documents that are not

loaded above the pick roller cannot be fed.

Incorrect

Pick Roller Assembly's Width

l Adjust the side guides to the widest document. If the side guides are not adjusted properly, a
paper jam may occur.

l Load smaller documents so that they can be scanned straight.
If the documents are skewed during scanning, the following problems may occur:
- Part of the document does not appear in the scanned image
- Slant lines appear in the scanned image

Scanning Documents of Different Widths or Lengths in One Batch
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- The documents are scanned in a wrong paper size
If the documents are not scanned straight, it is recommended that you select the [Continue
scanning after last page] checkbox in the [Scanning] tab of the "ScanSnap Setup Window"
(page 37), separate the documents by their widths, and scan them in different batches.

9. Press the [Scan] button on the ScanSnap to start a scan.

ATTENTION
Do not perform the following operations during scanning. Doing so will stop scanning.
l Connect or disconnect the ScanSnap and other USB devices.
l Close the ADF paper chute (cover).
l Switch users.
l Allow the computer to enter sleep mode.

a The [Scan] button on the ScanSnap flashes in blue while the documents are being
scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

a The Quick Menu appears when the scanning is completed.

10. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.

When you select , you can manage scanned images by folder with ScanSnap
Organizer.

For details, refer to "Managing Paper Documents by Folder on a Computer" (page 62).

Scanning Documents of Different Widths or Lengths in One Batch
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a The selected application starts up. For details, refer to the Advanced Operation Guide.

ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning Documents of Different Widths or Lengths in One Batch
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ScanSnap Overview

This section provides an overview that you should be aware of before operating ScanSnap.

l "Parts and Functions" (page 29)

l "System Requirements" (page 31)

l "Overview of the Software Related to the ScanSnap" (page 32)

l "How to Install the Software" (page 33)

l "ScanSnap Manager Icon" (page 34)

l "ScanSnap Manager Menu" (page 35)

l "ScanSnap Setup Window" (page 37)

l "Turning the ScanSnap On or Off" (page 38)

l "Documents to Scan" (page 44)

ScanSnap Overview
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Parts and Functions

This section explains the names and functions of the ScanSnap parts.

Front

3

1

2

5

4

6

No. Name Description

1 ADF paper chute (cover) (*1) Open it to use the ScanSnap.
Opening it turns on the ScanSnap. Then, you can load a document
on it.

2 ADF top section Open it to remove jammed documents, replace the Roller Set, or
clean the inside of the ScanSnap.

3 Extension Pull out when scanning long documents.

4 Side guide Adjust to the width of documents to prevent them from getting
skewed.

5 ADF release tab Pull this tab to open the ADF top section.

6 [Scan] button (*1) Starts scanning.
Indicates the status of the ScanSnap as follows:
Blue (lit): Ready
Blue (flashing): Scanning
Orange (flashing): Error

*1: When the ScanSnap has turned off automatically because of the automatic power off function,
either press the [Scan] button (this will not start scanning), or close the ADF paper chute (cover),
then open it again to turn the ScanSnap back on.

For details, refer to "Automatic Power OFF" (page 43).

Parts and Functions
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Back
7

8

9

10

No. Name Description

7 Tape seal Remove this tape seal after installing the software.

8 Security cable slot Used to connect an anti-theft security cable (commercially available).

9 Power connector Used to connect a power cable.

10 USB connector Used to connect a USB cable.

Parts and Functions
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System Requirements

The ScanSnap has the following system requirements.

For the latest information on requirements, please visit the ScanSnap Support Site at:

http://scansnap.fujitsu.com/g-support/en/

Operating system (*1) OS X v10.10
OS X v10.9 (recommended: 10.9.5 or later)
OS X v10.8 (recommended: 10.8.5 or later)
Mac OS X v10.7 (recommended: 10.7.5 or later)
Mac OS X v10.6 (recommended: 10.6.8) (*2)

CPU Intel® Core™ i5 2.5 GHz or higher

Memory 4 GB or more

Display resolution 1024 × 768 pixels or higher

Disk space Free space required to install the software bundled with the ScanSnap is as
follows:(*3)
l ScanSnap Manager: 640 MB
l ScanSnap Organizer: 100 MB
l CardMinder: 600 MB
l ABBYY FineReader for ScanSnap: 590 MB
l ScanSnap Online Update: 10 MB
l ScanSnap S1300i Basic Operation Guide: 100 MB

USB port USB 3.0 (*4)/USB 2.0/USB 1.1

*1: Updating Mac OS to the latest version is recommended.

*2: ScanSnap Organizer is not supported.

*3: To save scanned images, more free space is required.

For details about estimated image data size, refer to the ScanSnap Manager Help.

*4: When the ScanSnap is connected to a USB 3.0 port, the port operates as a USB 2.0 port.

ATTENTION
l If the system requirements above are not satisfied, the ScanSnap may not operate.
l If a USB port on the keyboard or on the monitor is in use, the ScanSnap may not operate.
l When using a commercially available USB hub, use a type that is powered from an electrical power

supply (and that comes with an adapter).
l Scanning speed decreases in the following cases:

- The CPU or the memory does not meet the recommended specifications.
- The version of the USB port or the USB hub is USB 1.1.

l To scan a document, a disk space that is approximately three times larger than the size of the file
to be saved is required.

System Requirements
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Overview of the Software Related to the ScanSnap

This section gives an overview of each bundled software and their functions. You can edit, manage,
and arrange the scanned image by using the following software:

ScanSnap Manager
This scanner driver is required to scan documents with the ScanSnap. Scanned images can be
saved as PDF or JPEG files to a computer.

You need to have ScanSnap Connect Application installed on your mobile device to save PDF or
JPEG files to your mobile device.

You can download ScanSnap Connect Application for your mobile device from its application
market.

ScanSnap Organizer
You can use this application to display image data (PDF or JPEG files) in a list, create folders, and
arrange files as you like.

CardMinder
You can use this application to efficiently digitalize a large number of business cards.

Text recognition can be performed on business cards and you can create a database to facilitate
card data management and searches. Data in the database can be printed and linked with various
applications. The data can be also shared with PIM (Personal Information Manager), such as
Contacts ("Address Book" for Mac OS X v10.7).

ABBYY FineReader for ScanSnap
This application can perform text recognition on the scanned images using OCR (Optical
Character Recognition) to convert the image data to Word, Excel, or PowerPoint files that can be
edited.

ScanSnap Online Update
This application checks whether the latest updates or software programs are available on the
download server. When the latest updates or software programs are available, you can
automatically apply updates or download and install the software programs manually.

Evernote for Mac
You can easily save files in Evernote using the ScanSnap.

Dropbox for Mac
You can easily save files to your Dropbox folder using the ScanSnap.

Overview of the Software Related to the ScanSnap
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How to Install the Software

When you insert the Setup DVD-ROM into the DVD-ROM drive on your computer, the [ScanSnap]
window appears.

ATTENTION
l Do not connect the ScanSnap to the computer before installing the software. Doing so may cause

the ScanSnap not to be recognized by the computer. In that case, install the software, and then
reconnect the ScanSnap to the computer.

l If a DVD-ROM drive is not available, the installers for the software programs can be downloaded
from the following web page.
http://scansnap.fujitsu.com/g-support/en/

The functions of each button in the [ScanSnap] window are as follows.

Icon Function

ScanSnap Starts installing software.

Other Software Displays the [Other Software] window. From this window, you can access the
download web pages of the software programs.

Readme Displays the Readme file.

Manuals The [Manuals] window appears. You can refer to Safety Precautions, Getting Started,
the Basic Operation Guide (this manual), and the Advanced Operation Guide.

How to Install the Software
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ScanSnap Manager Icon

When ScanSnap Manager is running, the ScanSnap Manager icon is displayed in the Dock.

The ScanSnap Manager icon indicates whether or not ScanSnap Manager is successfully
communicating with the ScanSnap. The appearance of the icon changes according to the
communication status as shown below.

This manual assumes that the ScanSnap is powered by a power cable.

Communication Status ScanSnap Manager Icon

Communicating When the ScanSnap is powered by a power cable

When the ScanSnap is powered by a USB bus power cable

Not communicating

HINT
Turn the ScanSnap on to begin communication between ScanSnap Manager and the ScanSnap. For
details about how to turn on the ScanSnap, refer to "Turning the ScanSnap On" (page 39).

You can display the menu for scanning documents and ScanSnap Manager settings from the
ScanSnap Manager icon.

l Clicking while holding down the [control] key on the keyboard

Displays the "ScanSnap Manager Menu" (page 35).

l Clicking

Displays the Profile menu.

For details, refer to the Advanced Operation Guide.

ScanSnap Manager Icon
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ScanSnap Manager Menu

This menu appears when you click the ScanSnap Manager icon  in the Dock while holding down
the [control] key on the keyboard.

Click While Pressing the [control] 
Key on the Keyboard

Item Function

Duplex Scan Scans both sides of the document. Follows the settings configured in [Settings].

Simplex Scan Scans only one side of the document. Follows the settings configured in [Settings].

Settings Displays the "ScanSnap Setup Window" (page 37). You can configure the scan
settings in this window.

Profile Displays the Profile menu.
You cannot select this when the [Use Quick Menu] checkbox is selected in the
ScanSnap setup window.

Profile Management Displays the [ScanSnap Manager - Profile Management] window.
You cannot select [Profile Management] when the [Use Quick Menu] checkbox is
selected in the ScanSnap setup window.
For details, refer to the Advanced Operation Guide.

Connect by Wi-Fi Displays the [ScanSnap Manager - Connect by Wi-Fi] window.
Available with iX500 and iX100.

Check consumable status Displays the [ScanSnap Manager - Check consumable status] window.
You can reset the consumable counters after replacing the consumables.

Preferences Displays the [ScanSnap Manager - Preferences] window.

ScanSnap Manager Menu
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Item Function

Help Displays the following menu:
l Help

Opens the ScanSnap Manager Help.
l Troubleshooting

Displays [Troubleshooting] in the ScanSnap Manager Help.
l ScanSnap Portal Site

Opens the ScanSnap global homepage (http://scansnap.fujitsu.com).
l About ScanSnap Manager

Displays the [ScanSnap Manager - Version Information] window.
l ScanSnap information

Displays the [ScanSnap Manager - Scanner and driver information] window.
Displayed when the ScanSnap and computer are connected.

l Online Update
Starts the ScanSnap Online Update.
For details, refer to "Updating the Software" (page 94).

To establish connection Displayed when ScanSnap Manager is not communicating with the ScanSnap
correctly.

Options Displays the following menu:
l Keep in Dock

Adds the ScanSnap Manager icon  to the Dock.
l Open at Login

Automatically launches ScanSnap Manager when the computer is started up or
logged in.

l Show in Finder
Displays the contents of the [ScanSnap] folder by using the Finder.

Show All Windows (*1) Shows all windows from ScanSnap Manager in thumbnails.

Hide/Show Hides or shows all windows from ScanSnap Manager.

Quit Quits ScanSnap Manager.

*1: Displayed for Mac OS X v10.7 or later.

ScanSnap Manager Menu
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ScanSnap Setup Window

When you click the ScanSnap Manager icon  while holding down the [control] key on the
keyboard, and then select [Settings] from the "ScanSnap Manager Menu" (page 35), the following
ScanSnap setup window appears.

In the ScanSnap setup window, you can use the [Use Quick Menu] checkbox to specify whether or
not to use the Quick Menu. You can also use the profile buttons and detail setting tabs to specify
scan settings according to your scanning needs.

For details, refer to the ScanSnap Manager Help.

Profile Buttons

Detail Setting Tabs

ScanSnap Setup Window
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Turning the ScanSnap On or Off

This section explains how to turn the ScanSnap on or off.

l "Turning the ScanSnap On" (page 39)

l "Turning the ScanSnap Off" (page 41)

l "Sleep Mode" (page 42)

l "Automatic Power OFF" (page 43)

Turning the ScanSnap On or Off
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Turning the ScanSnap On

1. Turn on the computer.

a The computer starts up and the ScanSnap Manager icon  appears in the Dock.

HINT

l If the ScanSnap Manager icon  is not displayed in the Dock, click [Applications] from the
sidebar in Finder, click [ScanSnap], and then double-click [ScanSnap Manager].

l If ScanSnap Manager does not automatically start when you log in to the computer, display
the [System Preferences] window and select [Users & Groups] → [Current User] → [Login

Items] → [ ] → [ScanSnap] → [ScanSnap Manager].

2. Open the ADF paper chute (cover) of the ScanSnap to turn the power on.

a The [Scan] button flashes in blue. The button returns to being lit normally when document
scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

ATTENTION
With some computers, the initialization of the ScanSnap may be performed several times when
the computer is started up.

HINT

l It may take more time for the ScanSnap Manager icon in the Dock to change to 
depending on computer performance, operating environment, or loading, for example, when
many software programs are running at the same time.

l When the ScanSnap is turned on, a notification window notifies you of the ScanSnap's
communication status.
To disable notifications of the ScanSnap's communication status, change the setting in the
following procedure:

Turning the ScanSnap On or Off
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1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key on
the keyboard, and then select [Preferences] from the "ScanSnap Manager Menu" (page
35).
a The [ScanSnap Manager - Preferences] window appears.

2. Clear the [Notify of the communication status] checkbox in the [Status Display] list.

Turning the ScanSnap On or Off
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Turning the ScanSnap Off

1. Close the ADF paper chute (cover).

a The [Scan] button turns off.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

ATTENTION
l Close the ADF paper chute (cover) after putting the extension back.
l If moving the ScanSnap, first turn the power off and remove all cables.

The bottom part of the ScanSnap may become hot when the ScanSnap is being used but this
does not affect ScanSnap operation or cause any physical harm. Be careful not to drop the
ScanSnap when carrying it.

HINT
l The power of the ScanSnap is linked with the power of the computer to which the ScanSnap

is connected. If you keep the ScanSnap connected to the computer, you do not have to worry
about turning the power ON/OFF.

l With some computers, it may take 2 to 3 minutes until the light of the [Scan] button goes out
after the computer is turned off.

l When the ScanSnap is turned off, a notification window notifies you of the ScanSnap's
communication status.
To disable notifications of the ScanSnap's communication status, change the setting in the
following procedure:

1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key on
the keyboard, and then select [Preferences] from the "ScanSnap Manager Menu" (page
35).
a The [ScanSnap Manager - Preferences] window appears.

2. Clear the [Notify of the communication status] checkbox in the [Status Display] list.

Turning the ScanSnap On or Off
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Sleep Mode

When the ScanSnap is on and has not been used for one minute, it enters sleep (power saving)
mode.

Turning the ScanSnap On or Off
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Automatic Power OFF

When the ScanSnap is turned on and left unused for the specified time (default is "4 hours"), it will
turn itself off automatically.

To turn the ScanSnap back on, perform one of the following operations:

l Press the [Scan] button on the ScanSnap (this will not start scanning)

l Close the ADF paper chute (cover) and open it again

HINT
l To continue using the ScanSnap, reset the time until auto power-off by performing one of the

following:
- Load a document in the ScanSnap
- Press the [Scan] button on the ScanSnap
- Close the ADF paper chute (cover) and open it again

l You can change the time of the ScanSnap to turn off automatically or change the setting so that it
will not turn off automatically. Set according to the following procedures:

1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key on the
keyboard, and then select [Preferences] from the "ScanSnap Manager Menu" (page 35).
a The [ScanSnap Manager - Preferences] window appears.

2. In the [Power] list, change the settings for [Power setting] based on how it is connected.
l A notification window notifies you 5 minutes before the ScanSnap turns off automatically.

Turning the ScanSnap On or Off
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Documents to Scan

Conditions for documents that can be loaded into the ScanSnap are as follows:

Office paper, postcards, business cards
Document type Office paper, postcards, business cards

Paper weight 64 to 104.7 g/m2 (17 to 20 lb)

Paper size Width: 50.8 to 216 mm (2 to 8.5 in.)
Length: 50.8 to 360 mm (2 to 14.17 in.)
l For long page (*1)

216 × 863 mm (8.5 × 34 in.)

*1: Scanning starts when you hold down the [Scan] button on the ScanSnap for 3 seconds or longer.

ATTENTION
The following types of documents must not be scanned:
l Documents attached with the metals such as paper clips or staples that can damage the inside of

the ScanSnap
Remove the metals for scanning.

l Documents on which the ink is still wet
Wait until the ink dries completely to scan these documents.

l Documents larger than width 216 mm (8.5 in.), length 863 mm (34 in.)
l Documents other than paper such as fabric, metal foil, OHP film, or plastic card
l Documents with photographs or memo papers attached

Documents that you need to treat with caution
l Documents written in pencil

When you scan documents written in pencil, there may be black traces left on them. Also, dirt
accumulating on the rollers may cause feeding errors. Clean the rollers occasionally when you
scan such documents. For details about how to perform cleaning, refer to "Troubleshooting" in
the ScanSnap Manager Help.

l Carbonless paper

Carbonless paper may contain chemicals that can harm the pad assy and the rollers inside the
ScanSnap. Make sure to perform cleaning occasionally to maintain the scanner performance
when scanning carbonless paper. For details about how to perform cleaning, refer to
"Troubleshooting" in the ScanSnap Manager Help. Depending on the type of carbonless
paper, the life span of the scanner may be shortened compared to scanning office paper.

l Scanning the following types of documents can result in documents being damaged or
scanned incorrectly.

- Documents smaller than width 50.8 mm (2 in.), length 50.8 mm (2 in.)

- Documents that weigh less than 64 g/m2 (17 lb)

- Documents with an uneven surface (such as envelopes and paper sheets with attached
materials)

- Wrinkled or curled documents

- Folded or torn documents

- Tracing paper
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- Coated paper

- Photographs (photographic paper)

- Perforated or punched documents

- Documents that are not rectangular or square

- Carbon paper or thermal paper

- Documents with memo papers or sticky notes attached

Picture Postcards
Picture postcards can be scanned when a power cable connection is used.

Document type Picture postcards

Paper weight 64 to 326 g/m2 (17 to 87 lb)

Paper size Width: 50.8 to 100 mm (2 to 3.9 in.)
Length: 50.8 to 148 mm (2 to 5.8 in.)

ATTENTION
l All conditions below must be satisfied when scanning picture postcards. Otherwise, paper jam may

occur.
- Power cable connection
- Normal room temperature and humidity levels
- Load the picture postcard face-down in the ScanSnap

l When you scan photographs or picture postcards, be aware that the picture side may get damaged.
It is the responsibility of the customer to scan photographs or picture postcards.

Documents to Scan
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What You Can Do with Related Software

This section explains the basic operation procedure of software related to the ScanSnap and gives
an overview of its functions.

l "What You Can Do with the ScanSnap Organizer" (page 47)

l "What You Can Do with CardMinder" (page 52)

What You Can Do with Related Software
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What You Can Do with the ScanSnap Organizer

ScanSnap Organizer is an application used for displaying, organizing, and managing image data
(PDF or JPEG files) scanned with the ScanSnap.

You can use this application to create folders and arrange files for various uses.

Pages of a PDF file can be opened with an associated application to check the scanned image data.

Main Window

Scan documents with the ScanSnap

l "Basic Operation Procedure of ScanSnap Organizer" (page 48)

l "Managing Files" (page 49)

l "Using Files" (page 51)

What You Can Do with the ScanSnap Organizer
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Basic Operation Procedure of ScanSnap Organizer

This section explains the basic operation procedure of ScanSnap Organizer.

1. From the sidebar in Finder, select [Applications] → [ScanSnap Organizer],
and then double-click [ScanSnap Organizer] to start up ScanSnap Organizer.

2. Scan documents with the ScanSnap.
a A list of scanned images is displayed in ScanSnap Organizer.

What You Can Do with the ScanSnap Organizer
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Managing Files

For details about operations, refer to the ScanSnap Organizer Help.

Setting a Marked Character String as a Keyword
Keywords can be set to a PDF file by using the keyword setting function.

These keywords can be used when you search for PDF files.

When black and white documents that have been marked are scanned by the ScanSnap, the
marked character strings are set as keywords for the PDF file.

Mark the characters 
on a document

"Proposal" can be used as a keyword 
to search for the file

Document PDF file with a keyword

Proposal

Proposal

Scan the document 
with the ScanSnap

Recognizing a Character String in a Page to Embed It into the Page
By using text recognition (OCR) software, you can embed character strings into the page of a PDF
file scanned by the ScanSnap, and then search the PDF file using the character strings.

OCR recognizes "proposal" 
as textual information.

PDF file

"Proposal" can be used 
as a keyword 
to search for the fileProposal

What You Can Do with the ScanSnap Organizer
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Searching Files
You can search files that are managed in ScanSnap Organizer.

What You Can Do with the ScanSnap Organizer
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Using Files

For details about operations, refer to the ScanSnap Organizer Help.

Linking Files with Other Applications
You can use files with a variety of applications.

Sending Files by E-mail
Files can be sent by e-mail.

What You Can Do with the ScanSnap Organizer
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What You Can Do with CardMinder

CardMinder is an application used for displaying, organizing, and managing card image data
scanned with the ScanSnap.

This application digitalizes large amounts of business cards into images at a high speed and
recognizes text on those cards, thus allowing you to search for your clients' business cards from
those data quickly, and create your client databases conveniently. CardMinder uses an Optical
Character Recognition (OCR) engine to recognize text on cards and shares the data with Personal
Information Manager (PIM) applications.

CardMinder also enables business card data to be quickly searched from other applications.

Card

Scan using the scanner

CardMinder window

Recognized data

iPhoto  Contacts (*) Other formats
(vCard/CSV/Text/
ContactXML)
Example: Text format

*: This is named "Address Book" for  OS X v10.7 or earlier.

l "Basic Operation Procedure of CardMinder" (page 54)

l "Linking Card Data with Other Applications" (page 57)

l "Searching Card Data with the Basic Search Toolbar" (page 58)
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l "Searching Card Data with Keyboard Shortcuts" (page 59)

l "Attaching a File to Card Data" (page 60)

What You Can Do with CardMinder
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Basic Operation Procedure of CardMinder

This section explains the basic operation procedure of CardMinder.

1. Start CardMinder.
From the sidebar in Finder, select [Applications] → [CardMinder], and then double-click
[CardMinder].

2. Scan a card with the ScanSnap.
Load a card in the ScanSnap and press the [Scan] button to start scanning the card.

When scanning is complete, the information printed on the card (such as name, company, and
address) is automatically recognized as text and displayed in the Card Data Edit view.

The image data scanned from the card is displayed in the Card Image view.

ATTENTION
ScanSnap Manager must be installed on your computer when you want to recognize the
following languages:
l Chinese (simplified)
l Chinese (traditional)
l Korean

3. Check the card data.
Make sure that the front and back card images are correct, and that the text on the card
images are displayed correctly in the Card Data Edit view.
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Card Data Edit ViewCard Image View

4. If the language to be used for text recognition is different, perform text
recognition again in the following procedure:
1. Select [CardMinder] menu → [Preferences].

a The [General] window appears.

2. Select a language for the character strings to be recognized from [Recognition Language].

a The recognition language changes.

3. Close the [General] window.

4. Click the [Recognize] button on the Toolbar again.

a Character strings on the card data will be recognized as the selected language.

5. Correct the card data, if necessary.

What You Can Do with CardMinder
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The card data can be corrected in the following ways. For details, refer to the CardMinder
Help.

l Redoing the recognition process on the character strings in the selected areas

l Entering text directly in the Card Data Edit view

l Correcting the orientation of the card image or switching the front and back images

3 41 2

No. Description

1 Using the [Rotate] button, you can rotate the card image.

2 Using the [Modify Image] button, you can switch the front and back images of the card image, create
double-sided cards, and delete the back image.

3 By selecting character strings in the card image and then clicking the buttons of the appropriate fields in
the Card Data Edit view, you can redo the recognition process on the selected areas.

4 You can directly correct the text of each field in the Card Data Edit view.

6. Exit CardMinder.
Click [CardMinder] menu → [Quit CardMinder] to quit CardMinder.
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Linking Card Data with Other Applications

Click the following buttons on the Toolbar to use card data in a variety of applications.

The following explains an example in which the Toolbar is customized to display the [Application]
button.

1 2 3 4

No. Item Description

1 E-mail You can start an e-mail program, using the e-mail address specified in [E-mail] for
the card data as the destination address.

2 Internet search You can search the URL specified in [Website] for the card data with a web browser.

3 Outputting card data in
a different format

You can output card data in the vCard, CSV, text, or ContactXML format.

4 Linking card data with
another application

You can link card data with another application such as Outlook Express or
Salesforce CRM to use the card data in the linked application. You can also link card
data with USB media to use the card data on a different computer.

For details, refer to CardMinder Help.
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Searching Card Data with the Basic Search Toolbar

This section explains how to search card data with the CardMinder Basic Search Toolbar.

Find (Basic Search Toolbar)

To search card data, type in a search term (such as an individual name or a company name) in the
Basic Search Toolbar.

The search results are displayed in the Card Data List view.
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Searching Card Data with Keyboard Shortcuts

Even when CardMinder is not running, you can search card data by using a character string in
another application (such as TextEdit) as the keyword for searching.

1. Drag the mouse to select a character string you want to search for.

2. Press [command ] + [shift] + [&] keys on the keyboard at the same time.
a While the Card Data Edit view is hidden, CardMinder starts and search is executed.

Card data matching the search conditions is displayed in the Card Data List view.

HINT
l Depending on the keyboard type, you may not have to press the [shift] key.
l If the keyboard shortcuts do not work, check the [Search Selected Text in CardMinder] shortcut key

by selecting [System Preferences] → [Keyboard] → [Services] in the [Keyboard Shortcuts] tab, and
change the shortcut key to the one to be used.
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Attaching a File to Card Data

A file can be attached to card data easily by dragging and dropping it.

What You Can Do with CardMinder
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Useful Usages

This section explains how to use related software for the scanned image that is created after a
document is scanned with the ScanSnap and how to scan a document with a setting other than the
default setting.

l "Managing Paper Documents by Folder on a Computer" (page 62)

l "Saving Business Cards to a Computer" (page 65)

Useful Usages
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Managing Paper Documents by Folder on a Computer

This section explains how to digitize paper documents and manage the data by folder in ScanSnap
Organizer.

1. Scan a paper document with the ScanSnap.
For details about scanning a document, refer to "Scanning a Document" (page 15).

a The Quick Menu appears.

2. Click the [ScanSnap Organizer] icon  in the Quick Menu.
a The [ScanSnap Organizer] window appears.

Managing Paper Documents by Folder on a Computer
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3. From the menu bar, select [File] → [New Folder].
a A new folder is created in the folder list.

4. Rename the created folder.

HINT
To create multiple folders, repeat steps 3 to 4.

5. Select the scanned image from the file list, and drag and drop it to the folder.

Managing Paper Documents by Folder on a Computer
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a The scanned image is moved to the folder.

HINT
For details about other functions, refer to the ScanSnap Organizer Help.

Managing Paper Documents by Folder on a Computer
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Saving Business Cards to a Computer

This section explains how to digitize business cards and save the card data in CardMinder.

ATTENTION
If you do not log in as a user with Administrator privileges, you may not be able to link the ScanSnap
with another application properly.

1. Scan business cards with the ScanSnap.
For details about scanning business cards, refer to "Scanning a Document" (page 15).

a The Quick Menu appears.

2. Click the [CardMinder] icon  in the Quick Menu.
a The [CardMinder] window appears.

Saving Business Cards to a Computer
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3. Check the card data.
Make sure that the text on the card images are displayed correctly in the Card Data Edit view.

If the card data must be corrected, click the text to be corrected and then directly edit it.

Card Data Edit ViewCard Image View

HINT
When you scan double-sided business cards, you must scan one side of each card and edit the card
data in CardMinder.
For details, refer to the CardMinder Help.

Saving Business Cards to a Computer
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Troubleshooting

This section explains how to solve troubles you may encounter upon installing the software related
to the ScanSnap.

l "If You Have Installed the Software Before" (page 68)

l "When the ScanSnap Manager Icon Does Not Appear" (page 69)

l "When ScanSnap Manager Does Not Operate Normally" (page 71)

For details about the troubles you may encounter and the solutions while using the ScanSnap, refer
to the following:

l "Troubleshooting" in the ScanSnap Manager Help

To display this section, click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and select [Help] → [Troubleshooting] from the "ScanSnap
Manager Menu" (page 35).

l ScanSnap Support Site (http://scansnap.fujitsu.com/g-support/en/)

If you cannot solve the problem after referring to the above section, contact your FUJITSU scanner
dealer or an authorized FUJITSU scanner service provider.

Troubleshooting
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If You Have Installed the Software Before

If your attempt to reinstall the software related to the ScanSnap (including models other than S1300i)
failed, uninstall the software and then reinstall it.

For details, refer to the following:

l "Uninstalling the Software" (page 95)

l "How to Install the Software" (page 33)
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When the ScanSnap Manager Icon Does Not Appear

This section explains how to troubleshoot when the ScanSnap Manager icon  does not appear in
the Dock even though the software is installed and the ScanSnap is connected to the computer.

l "Displaying the ScanSnap Manager Icon" (page 70)

When the ScanSnap Manager Icon Does Not Appear
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Displaying the ScanSnap Manager Icon

1. From the sidebar in Finder, select [Applications] → [ScanSnap], and then
double-click [ScanSnap Manager] to start ScanSnap Manager.

HINT
If the problem is solved, you can change the setting so that ScanSnap Manager will start up
automatically from the next time you log in to the computer.
The procedure is as follows.

l On the [System Preferences] window displayed from the Apple ( ) menu, select [Users &

Groups] → [Current User] → [Login Items] → [ ] → [ScanSnap] → [ScanSnap Manager].

l Click the ScanSnap Manager icon  in the Dock while holding down the [control] key on the
keyboard, and then select [Options] → [Open at Login] from the displayed menu.

If the problem persists, refer to "When ScanSnap Manager Does Not Operate Normally" (page 71).
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When ScanSnap Manager Does Not Operate
Normally

If the ScanSnap Manager icon in the Dock is displayed as  even though the software is installed
and the ScanSnap is connected to the computer, perform the following procedures.

l "Checking the Connection between the ScanSnap and the Computer" (page 72)

l "Checking If ScanSnap Manager Is Operating Normally" (page 73)

When ScanSnap Manager Does Not Operate Normally
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Checking the Connection between the ScanSnap and the
Computer

1. Unplug the USB cable from the computer and the ScanSnap, then plug it
back in.
Make sure to leave at least 5 seconds between unplugging and plugging the cable.

If you are using a USB hub, connect the USB cable to the computer directly.

If the problem persists, refer to "Checking If ScanSnap Manager Is Operating Normally" (page 73).
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Checking If ScanSnap Manager Is Operating Normally

1. Turn off the ScanSnap and then turn it on again.
Make sure to leave at least 5 seconds between turning off and on the ScanSnap.

If the problem persists, proceed to step 2.

2. If you are using a USB hub, connect the ScanSnap to the computer directly
with a USB cable.

If the problem persists, proceed to step 3.

3. Turn off the ScanSnap and restart the computer.

If the problem persists, refer to "If You Have Installed the Software Before" (page 68). If the problem still persists,
perform the procedures described in "When ScanSnap Manager Does Not Operate Normally" (page 71) once
again.
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Cleaning

This section explains about the cleaning materials and how to clean the ScanSnap.

l "Cleaning Materials" (page 75)

l "Cleaning the Outside of the ScanSnap" (page 76)

l "Cleaning the Inside of the ScanSnap" (page 77)
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74



Cleaning Materials

Cleaning materials and their part numbers are as below.

Product Name Part No. Unit Note

Cleaner F1 PA03950-0352 1 bottle Size: 100 ml

Cleaning Paper (*1) CA99501-0012 1 pack 10 sheets

Cleaning Wipe (*2)

PFU LIMITED

PA03950-0419 1 pack 24 packets

Lint-free dry cloth (*3) Commercially
available

- -

*1: Used with Cleaner F1.

*2: The cleaning wipes are wet tissues that have been soaked with Cleaner F1. In place of this
product, you can use a cloth soaked with Cleaner F1.

*3: Any lint-free cloth can be used.

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
details about purchasing the cleaning materials.

For details, refer to the following web page:

http://scansnap.fujitsu.com/

Cleaning Materials
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Cleaning the Outside of the ScanSnap

Clean the outside of the ScanSnap, the ADF paper chute (cover), and the ADF top section in the
following procedure.

1. Unplug the cables from the ScanSnap.

2. Clean the outside of the ScanSnap with a dry cloth, or a cloth moistened with
Cleaner F1/mild detergent.

ATTENTION
l Never use paint thinner or any other organic solvents. The shape or color may be changed.
l When cleaning the ScanSnap, prevent liquids from entering the ScanSnap.
l It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten the

cloth with moderate quantity. Wipe off the cleaner completely with a soft cloth to leave no
residue on the cleaned parts.

Cleaner F1 or
Mild DetergentCloth

Cleaning the Outside of the ScanSnap
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Cleaning the Inside of the ScanSnap

Scanning repeatedly may cause dust and paper dust to accumulate inside the ScanSnap resulting in
a scanning error.

As a guideline, the inside of the ScanSnap should be cleaned every 200 sheets scanned. Note that
this guideline varies depending on the types of documents you scan. For instance, it may be
necessary to clean the scanner more frequently when you scan documents on which the toner is not
sufficiently fused.

�������
l Before cleaning the ScanSnap, you must turn off the ScanSnap and unplug

the power connection cable (power cable or USB bus power cable) from the
power supply source (AC outlet or computer). Not doing so may cause fire
or electrical shock.

l Do not place internal parts such as the pad assy and the pick roller
assembly within reach of small children. Doing so may cause injury.

l When the ScanSnap is operating, the internal glass surface will be hot.

Before you clean the inside of the ScanSnap, you must unplug the power
connection cable (power cable or USB bus power cable) from the power
supply source (AC outlet or computer) and leave the ScanSnap for 15
minutes or more.

 

�������
l Do not use aerosol spray or spray that contains alcohol to clean the

scanner. Paper dust and other dust blown up by strong air from the spray
may enter the inside of the scanner which may cause scanner failure or
malfunction.

Also note that sparks generated by static electricity may cause a fire.

l While cleaning, pay attention to the inside structure of the ScanSnap and
avoid accidentally getting your hand or a cloth caught on the pick spring
(metal part). Otherwise, the pick spring (metal part) may be deformed, which
causes injury.

 

ATTENTION
l Do not use water or mild detergent to clean the inside of the ScanSnap.
l It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten the cloth with

moderate quantity.
Wipe off the cleaner completely to leave no residue on the cleaned parts.

HINT
To check the number of sheets scanned with the ScanSnap, see [Total Page Count] in the [ScanSnap
Manager - Check consumable status] window.
To open the [ScanSnap Manager - Check consumable status] window, click the ScanSnap Manager

icon  in the Dock while holding down the [control] key on the keyboard, and select [Check
consumable status] from the "ScanSnap Manager Menu" (page 35).

1. Clean the following items:
l Pad assy

Cleaning the Inside of the ScanSnap

77



l Idler roller

l Glass

l Pick roller assembly

l White backing strip

1. Unplug the power connection cable (power cable or USB bus power cable) from the power
supply source (AC outlet or computer).

2. Pull the ADF release tab to open the ADF top section.

ADF Paper Chute (Cover)

ADF Release Tab

ADF Top Section

3. Clean the following locations with a cloth moistened with Cleaner F1.

Pad Assy

Pick Spring (Metal Part)
*Gray Part

Pick Roller Assembly

White Backing Strip (x 2)
(including the one on the ADF 
top section)
Glass (x 2)
(including the one on the ADF 
top section)

Idler Roller
 (x 4)

l Idler roller (× 4, located on the ADF top section)

Gently wipe the dirt and dust off the rollers as you rotate them manually. Be careful not
to damage the surface of the rollers. Make sure that they are cleaned properly because
residue on the rollers will affect the feeding performance.

l Pad assy (× 1, located on the ADF top section)

Wipe the rubber surface of the pad downward to remove any dirt and dust. Be careful
not to accidentally get your hand or a cloth on the pick spring (metal part).

l Pick roller assembly (× 1)
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Gently wipe the dirt and dust off the rollers as you manually rotate them downward. Be
careful not to damage the surface of the rollers. Make sure that they are cleaned
properly because residue on the rollers will affect the feeding performance.

l Glass (× 2, one on the ADF top section and one on the opposite side)

Gently wipe the dirt and dust off the surface of the glass sections. Make sure that they
are cleaned properly because dirty glass sections may cause vertical lines on scanned
images.

l White backing strip (× 2, one on the ADF top section and one on the opposite side)

The white sections at the edge of the glass sections. Gently wipe the dirt and dust off
the surface.

2. Clean the feed rollers and eject rollers.
1. Connect the power connection cable (power cable or USB bus power cable) to the power

supply source (AC outlet or computer), and press the [Scan] button for three seconds with
the ADF top section open.

ATTENTION
Connect the power connection cable (power cable or USB bus power cable) to the power
supply source (AC outlet or computer) only when cleaning the feed rollers and eject rollers.

2. Clean the following locations with a cloth moistened with Cleaner F1.

Eject Roller
 (x 2)

Feed Roller
 (x 2)

l Feed roller (× 2)/eject roller (× 2)

Press the [Scan] button to rotate the rollers. Gently wipe the dirt and dust off while
taking care not to damage the surface of each roller. Make sure that they are cleaned
properly because residue on the rollers will affect the feeding performance.

HINT
Pressing the [Scan] button seven times will rotate the feed rollers and the eject rollers
one revolution.

3. Close the ADF top section.
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ADF Paper Chute (Cover)

ADF Top Section

a It clicks when it returns to its original position.

ATTENTION
Make sure that the ADF top section is completely closed.
Otherwise, paper jams or other feeding errors, or image faults may occur.

Cleaning the Inside of the ScanSnap
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Consumables

This section explains about the consumable part numbers, replacement cycles and how to replace
the consumables.

�������
l Before replacing consumables, you must turn off the ScanSnap and unplug

the power connection cable (power cable or USB bus power cable) from the
power supply source (AC outlet or computer). Not doing so may cause fire
or electrical shock.

l Do not place internal parts such as the pad assy and the pick roller
assembly within reach of small children. Doing so may cause injury.

 

ATTENTION
The bottom part of the ScanSnap may become hot when the ScanSnap is being used but this does not
affect ScanSnap operation or cause any physical harm. Be careful not to drop the ScanSnap when
carrying it.

l "Part Numbers and Replacement Cycle of Consumables" (page 82)

l "Checking the Status of Consumables" (page 83)

l "Replacing Consumables" (page 84)

Consumables

81



Part Numbers and Replacement Cycle of
Consumables

The following table shows the part number of the consumables and the suggested replacement
cycles.

Product Name Part No. Suggested replacement cycle

PAD ASSY PA03541-0002 10,000 sheets or one year

PICK ROLLER PA03541-0001 100,000 sheets or one year

Note that the suggested replacement cycles are guidelines for using A4 (80 g/m2 [20 lb]) wood-free
paper, as these cycles vary depending on the type of documents scanned.

Only use the specified consumables.

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
details about purchasing the consumables.

For details, refer to the following portal site:

http://scansnap.fujitsu.com/

Part Numbers and Replacement Cycle of Consumables
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Checking the Status of Consumables

You can check the status of each consumable in the following procedure.

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and then select [Check consumable status]
from the "ScanSnap Manager Menu" (page 35).
a The [ScanSnap Manager - Check consumable status] window appears.

2. Check the status of each consumable.
Refer to [Suggested replacement cycle] as a guideline and replace the consumables.
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Replacing Consumables

This section explains how to replace the pad assy and the pick roller assembly.

l "Replacing the Pad Assy" (page 85)

l "Replacing the Pick Roller Assembly" (page 88)

Replacing Consumables
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Replacing the Pad Assy

Replace the pad assy in the following procedure:

1. Unplug the power connection cable (power cable or USB bus power cable)
from the power supply source (AC outlet or computer).

2. Remove any documents from the ADF paper chute (cover).

3. Pull the ADF release tab to open the ADF top section.

ADF Paper Chute (Cover)

ADF Release Tab

ADF Top Section

4. Remove the pad assy.
Hold the both ends of the pad assy and remove it in the direction of the arrow.

Pad Assy

ADF Top Section

5. Attach the new pad assy while pressing the pad plate.
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Pad Assy

ADF Top Section

Pad Plate

ATTENTION
Attach the pad assy with the front side up.
If the pad assy is attached upside down, paper jams or other feeding errors may occur.

Correct Incorrect

Front Back

6. Make sure that the pad assy is attached to the retaining hook firmly.

ATTENTION
Make sure that the pad assy is attached firmly. Otherwise, paper jams or other feeding errors
may occur.

7. Close the ADF top section.

ADF Paper Chute (Cover)

ADF Top Section

→ It clicks when it returns to its original position.

8. Connect the power connection cable (power cable or USB bus power cable)
to the power supply source (AC outlet or computer), and turn on the
ScanSnap.

9. Reset the pad assy count.
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1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key on
the keyboard, and then select [Check consumable status] from the "ScanSnap Manager
Menu" (page 35).

→ The [ScanSnap Manager - Check consumable status] window appears.

2. Click the [Reset] button for [PAD ASSY Count].

→ A confirmation window appears.

3. Click the [Yes] button.

→ [PAD ASSY Count] is reset to 0.

Replacing Consumables

87



Replacing the Pick Roller Assembly

Replace the pick roller assembly in the following procedure:

1. Unplug the power connection cable (power cable or USB bus power cable)
from the power supply source (AC outlet or computer).

2. Remove any documents from the ADF paper chute (cover).

3. Pull the ADF release tab to open the ADF top section.

ADF Paper Chute (Cover)

ADF Release Tab

ADF Top Section

4. Remove the sheet guide.
While holding the squeeze clip on the right end and pressing it inward, lift the sheet guide to
remove it.

Squeeze 
Clip

Squeeze 
Clip

Sheet Guide

5. Turn the bushing that is on the left.
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Bushing

Shaft

Pick Roller Assembly

6. Remove the shaft of the pick roller from the ScanSnap.
Lift the left side of the shaft slightly (about 5 mm), move it toward the left, and then lift it upward
to pull it out.

Pick Roller Assembly
Shaft

ATTENTION
There may be paper dust around the pick roller assembly.
Wipe off the paper dust with a cloth moistened with Cleaner F1. Not doing so may cause image
faults.
Do not use water, mild detergent, or aerosol spray.

7. Remove the pick roller assembly from the shaft.
→ While lifting the retaining clip of the pick roller assembly, pull out the shaft.

Pick Roller Assembly
Shaft
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ATTENTION
Lifting the retaining clip with your fingernail may hurt or damage your fingernail.
Use a paper clip or something alike if you have trouble lifting it up.

8. Attach the new pick roller assembly to the shaft.
Insert the drive pin of the shaft into the slot of the pick roller assembly.

Pick Roller Assembly

Drive Pin

Shaft

9. Attach the shaft to the ScanSnap.
Insert the right end of the shaft into the bushing on the right side, and then slowly attach the left
end of the shaft into place.

Pick Roller Assembly
Shaft

10. Secure the bushing on the left.
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Bushing

Shaft

Pick Roller Assembly

ATTENTION
Make sure that the shaft is attached firmly. Otherwise, paper jams or other feeding errors may
occur.

11. Attach the sheet guide.
While holding the squeeze clip on the right end, attach the sheet guide to its original position.

Squeeze 
Clip

Squeeze 
Clip

Sheet Guide

→ It clicks when the squeeze clip is locked in place.

ATTENTION
Make sure that the sheet guide is attached firmly. Otherwise, paper jams or other feeding errors
may occur.

12. Close the ADF top section.

ADF Paper Chute (Cover)

ADF Top Section

→ It clicks when it returns to its original position.
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13. Connect the power connection cable (power cable or USB bus power cable)
to the power supply source (AC outlet or computer), and turn on the
ScanSnap.

14. Reset the pick roller count.

1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key on
the keyboard, and then select [Check consumable status] from the "ScanSnap Manager
Menu" (page 35).

→ The [ScanSnap Manager - Check consumable status] window appears.

2. Click the [Reset] button for [PICK ROLLER Count].

→ A confirmation window appears.

3. Click the [Yes] button.

→ [PICK ROLLER Count] is reset to 0.
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Appendix

l "Updating the Software" (page 94)

l "Uninstalling the Software" (page 95)

l "Specifications of the ScanSnap" (page 102)
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Updating the Software

Latest updates for ScanSnap related software are available for free from our download server. This
is called ScanSnap Online Update.

It is recommended that you apply latest updates to enhance security, operability and functions.

For the software programs that can be updated, refer to the following:

http://www.fujitsu.com/global/support/computing/peripheral/scanners/software/online-setup-help.html

ScanSnap Online Update checks the download server periodically.

When the latest version of ScanSnap is available, the update list window appears.

To install the update, follow the instructions on the window.

For details, refer to the ScanSnap Online Update Help.

You can also manually check from ScanSnap Manager whether a newer version of the program is
available and run the update.

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and click [Help] → [Online Update] from the
"ScanSnap Manager Menu" (page 35).
a ScanSnap Online Update checks whether a newer version of ScanSnap Manager is

available. Proceed with the update as you follow the instructions.

For details, refer to the ScanSnap Online Update Help.

ATTENTION
l To run the online update for ScanSnap Manager, you need to have access to the Internet.
l Log in as a user with Administrator privileges.

HINT
For details about updates of ScanSnap Manager, visit the following web pages:
http://scansnap.fujitsu.com/g-support/en/
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Uninstalling the Software

This section explains how to uninstall the following software programs:

l "Uninstalling ScanSnap Manager" (page 96)

l "Uninstalling ScanSnap Organizer" (page 98)

l "Uninstalling CardMinder" (page 99)

l "Uninstalling ABBYY FineReader for ScanSnap" (page 100)

l "Uninstalling ScanSnap Online Update" (page 101)
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Uninstalling ScanSnap Manager

Uninstall ScanSnap Manager.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. From the sidebar in Finder, select [Applications] → [ScanSnap] → [Sub], and
then double-click [ScanSnap Uninstaller].
a The [ScanSnap Uninstaller] window (the [Welcome to ScanSnap Uninstaller] screen)

appears.

3. Click the [Continue] button.
a The [Important Information] screen appears.

4. Read [Read Me], and then click the [Uninstall] button.
a The authentication window appears.

5. Enter the user name and password for a user with Administrator privileges,
and click the [OK] button.
a Uninstallation starts. When the uninstallation is complete, [Uninstall Succeeded] screen

appears.

6. Click the [Close] button.

HINT
When a user other than the user who uninstalled ScanSnap Manager has set ScanSnap
Manager as a login item, the following operations are required:
1. Log in as a user who has set ScanSnap Manager as a login item.

2. From the Apple ( ) menu, select [System Preferences].
a The [System Preferences] window appears.

3. Select [Users & Groups].
a The [Users & Groups] window appears.

4. From [Current User], select the currently logged-in user.

5. Select the [Login Items] tab.
a A list of login items appears.

6. From the list of login items, select [ScanSnap Manager].

7. Click the [ ] button under the list of login items.
a [ScanSnap Manager] is deleted from the list of login items.
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8. Close the [Users & Groups] window.
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Uninstalling ScanSnap Organizer

Uninstall ScanSnap Organizer.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ScanSnap Organizer if it is running.

3. From the sidebar in Finder, select [Applications] → [ScanSnap Organizer],
and drag the [ScanSnap Organizer] folder into the Trash.

4. Empty the Trash.
a The [ScanSnap Organizer] folder is deleted.

Uninstalling the Software

98



Uninstalling CardMinder

Uninstall CardMinder.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit CardMinder if it is running.

3. From the sidebar in Finder, select [Applications] → [CardMinder], and drag
the [CardMinder] folder into the Trash.

4. Empty the Trash.
a The [CardMinder] folder is deleted.

HINT
To delete the database, drag the database file into the Trash.
To access the database file stored in the default location, select [Documents] → [CardMinder] →
[CardMinder DB.cxdb] from the sidebar in Finder.
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Uninstalling ABBYY FineReader for ScanSnap

Uninstall ABBYY FineReader for ScanSnap.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ABBYY FineReader for ScanSnap if it is running.

3. From the sidebar in Finder, select [Applications] → [ABBYY FineReader for
ScanSnap], and drag the [ABBYY FineReader for ScanSnap] folder into the
Trash.

4. Empty the Trash.
a The [ABBYY FineReader for ScanSnap] folder is deleted.
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Uninstalling ScanSnap Online Update

Uninstall ScanSnap Online Update.

HINT
Before uninstalling ScanSnap Online Update, make sure that none of the following software is
installed.
l ScanSnap Manager
l ScanSnap Organizer
l CardMinder

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. From the sidebar in Finder, select [Applications] → [ScanSnap Online
Update] → [Sub], and then double-click [AOUUninstaller].
a The [ScanSnap Online Update Uninstaller] window ([Welcome to ScanSnap Online Update

Uninstaller]) appears.

3. Click the [Continue] button.
a The [Important Information] screen appears.

4. Read [Read Me], and then click the [Uninstall] button.
a The authentication window appears.

5. Enter the user name and password for a user with Administrator privileges,
and click the [OK] button.
a Uninstallation starts. When the uninstallation is complete, [Uninstall Succeeded] screen

appears.
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Specifications of the ScanSnap

The following table summarizes the specifications of the ScanSnap.

Item Specification

Product Name ScanSnap S1300i

Scanning method Automatic Document Feeder (ADF), simultaneous duplex
scanning

Scanning color mode Simplex/duplex, color/gray/black and white/auto (automatic
color, gray, and B&W detection)

Optical system/image sensor Selfoc lens equal-magnification optics/color CIS × 2 (front × 1,
back × 1)

Light source 3 color LED (Red/Green/Blue)

Scanning speed (A4
portrait)

Power cable connection Automatic resolution: 6 sheets/minute
Normal: 12 sheets/minute
Better: 9 sheets/minute
Best: 6 sheets/minute
Excellent: 1 sheet/minute

USB bus power cable
connection

Automatic resolution: 2 sheets/minute
Normal: 4 sheets/minute
Better: 3 sheets/minute
Best: 2 sheets/minute
Excellent: 1 sheet/minute

Scan area Refer to "Documents to Scan" (page 44)

Document thickness

Number of sheets allowed to be loaded Up to 10 sheets
A4: 80 g/m2 (20 lb)

Interface USB USB 2.0/USB 1.1 (connector: USB Mini-B type) (*1)

Input power Voltage 100 to 240 V ±10% or 5 V (USB bus power)

Phase Single phase

Frequency range 50/60 Hz

Power consumption Power cable connection During operation: 9 W or less
During sleep mode: 2.6 W or less

USB bus power cable
connection

During operation: 5 W or less
During sleep mode: 2 W or less

Temperature/humidity
allowable ranges

Temperature During operation: 5 to 35 degrees C/41 to 95 degrees F
During standby: -20 to 60 degrees C/-4 to 140 degrees F
During storage/transportation: -20 to 60 degrees C/-4 to 140
degrees F

Humidity During operation: 20 to 80%
During standby: 8 to 95%
During storage/transportation: 8 to 95%

Outer dimensions (Width × Depth × Height) Min.: 284 × 99 × 77 mm/11.18 × 3.90 × 3.03 in. (when the
ADF paper chute (cover) is closed)
Max.: 284 × 231 × 240 mm/11.18 × 9.09 × 9.45 in. (when the
ADF paper chute (cover) is open and the extension is
extended)

Weight 1.4 kg (approx. 3.09 lb)
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Item Specification

Environmental specification Compliant with the International Energy Star Program, and
RoHS Directive

Related Software Scanner driver ScanSnap Manager

File management ScanSnap Organizer

Business card
management

CardMinder

Text recognition ABBYY FineReader for ScanSnap

Update management
and application

ScanSnap Online Update

*1: When the ScanSnap is connected to a USB 3.0 port, the port operates as a USB 2.0 port.
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About Customer Support and Maintenance

Customer Support
l ABBYY FineReader for ScanSnap

From the sidebar in Finder, select [Applications] → [ABBYY FineReader for ScanSnap] →
[ABBYY FineReader for ScanSnap] → [Help] → [ABBYY FineReader for ScanSnap Help] →
[Technical Support].

l Evernote

Refer to the following web page:

http://www.evernote.com/about/contact/support/

l Google Docs

Refer to the Google Docs editors Help Center or the Google Docs Help Forum.

To open them, select [Help] in Google Docs.

l Salesforce

Contact the system administrator of your Salesforce.

l Dropbox

Refer to the following web page:

http://www.dropbox.com/contact

l ScanSnap

For other inquiries on the ScanSnap, refer to the ScanSnap Support Site.

http://scansnap.fujitsu.com/g-support/en/

If your problem cannot be solved after referring to the above web pages, visit the following web
page to check the contact information of a suitable Fujitsu office and contact the Fujitsu office.

http://imagescanner.fujitsu.com/warranty.html

Suppliers of Consumables/Optional Parts
http://scansnap.fujitsu.com/

Maintenance
Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
repairs on this product.

For details, refer to the following portal site:

http://imagescanner.fujitsu.com/warranty.html

ATTENTION
For safety reasons, never attempt repairs by yourself.
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